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TM011 – 3D imaging WiRE™ 5 
 
This document aims to show the WiRE™ 5 users how to collect, process, analyse and view 
3D volume data. 
 
In order to use this capability ensure the StreamLineHR (optionally with Rapide) and 3D 
passwords have been purchased and entered into the WiRE Feature permissions. 
 
Collection of data 
 
3D data collection can be achieved using StreamLineHR (TM009) or StreamLineHR Rapide 
(TM029) measurement types. Prior to the set-up and collection of data, it is recommended 
that the Z distance of the volume be separately investigated to ensure values used within the 
volume are appropriate for the analysis. 
 
The set-up of the volume measurement combines the collection of StreamLineHR or 
StreamLineHR Rapide data in XY with an additional Z control for each collected XY plane. 
The resulting spectra within the dataset, covering the 3 spatial dimensions, are analysed 
together to produce a single hypercube of spectra. This enables spectral information to be 
analysed in all dimensions simultaneously. 
 
Refer to the StreamLineHR Rapide training module (TM029) for further information. 
 

1. Select Volume acquisition from the new measurement options.  

 
 
 
 
 
 
 
 
 
 
 
 

2. Define the collection area on the live video image (video viewer), or snap / montage 
image (still image viewer). 
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The StreamLineHR box is automatically ticked, and cannot be un-ticked. 
 
The XY first and last values, and the step size (in µm) can be adjusted both within 
this dialogue and within the Map measurement set-up dialogue. 
 
The number of points can be changed. This shows the image size in pixels, each 
pixel consisting of a Raman spectrum. 
 

3. When the map is defined, and OK is pressed, the Map Measurement Setup window 
is activated. The Range, Acquisition, File, and Advanced tabs are identical to those 
that appear in the general Spectral Acquisition setup.  
 
The Depth series and Area setup tabs allow the user to review and adjust the 
settings for the XYZ spatial values 

 
4. Set the Depth information by entering the Start position (µm) and the number of 

acquisitions in the Z dimension. The interval value (µm) then defines the final position 
(the interval value can be set to be positive or negative to ensure the appropriate 
volume is imaged). 
 
See TM5 for detailed information on using the depth series measurement tab. 
 
The total number of spectra to be collected is shown in the Area setup tab and 
includes the Z depth number. 
 

5. Go to the ‘Range’ tab and set the centre position of the scan (the spectral range and 
spectral resolution will depend on the laser wavelength, grating groove density and 
detector type). 
 

6. Go to the ‘Acquisition’ tab and select the time and laser power to be used with the 
scan. StreamLineHR has a minimum exposure time of 0.05 s (50 ms). StreamLineHR 
Rapide can use less than 0.001 s (1 ms) 
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7. Go to the 'File' tab and define the filename and location. Select the 'Auto increment' 

option to ensure the data cannot be overwritten. 
 

8. Once OK is pressed, the Volume acquisition measurement can be started using the  
button.  
 

Data will be collected in XY planes at the specified Z depths. 
  
Data processing 
 
The following processing options are available to be applied to the 3D dataset within WiRE: 
 

• Baseline subtraction 
• Cosmic ray removal 
• Noise filtering  
• Truncate 
• Differentiate 
• Normalise 
• Smooth 
• Zap 

 
Data analysis 
 
All image generation options are available for the 3D dataset. (See TM14 and TM15) 
 
 
Viewing and manipulating the volume image 

 
Loading volume images 
 
Once the volume images have been generated from the mapping data they can be viewed 
by selecting the appropriate single image within the map review dialogue. This will launch 
the data into the volume viewer where all generated volume images are accessible.  
 
More than 10 volume images can be viewed simultaneously within the volume viewer. 
Additional volumes can be added to the initially loaded image. Select the ‘Volumes’ tab, 
highlight the image to be loaded and select ‘Load’. 
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The ‘View Control’ tab houses options to enable loaded images to be temporarily hidden 
(un-tick box) or made active (click on image name). The look-up table is shown for the active 
image and layers this image on top of any other loaded images. 
 

 
 
Once loaded, the order of the layers can be adjusted using the up and down arrows. 
 
Controlling the volume image 
 
The volume image can be spatially manipulated using the following options: 
 

• Free rotate (hold down left mouse button and move mouse) 
• Constrained rotate (hold down Ctrl key on keyboard to restrict axis of rotation) 
• Zoom (use mouse wheel) 
• Translate (click background of image view, hold down mouse wheel button and move 

mouse) 
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The colour, contrast, and transparency of volume pixels (voxels) within the volume image 
are controlled using the look up table (LUT). The volume viewer LUT is similar to that within 
WiRE. 
The LUT consists of 

• Data histogram 
• Black triangle drag bars on the data to control mapped colour values (also 

controllable by entering numbers and using the spin boxes). This controls the image 
contrast. 

• White box drag bars on the data to control mapped transparency values (also 
controllable by entering numbers and using the spin boxes) 

• A 5% - 95% auto button 
 

 
Colour control 
To change the colour scheme, use the dropdown. It is worth noting that the simple 
colours vary on a linear scale, whilst the more complex schemes vary non-linearly.  
 
Data (image value) histogram 
The bottom red trace shows a histogram of image values. The left number indicates 
image values to be represented as black and the right number image values to be 
represented as white (for grey colour selection). The data between these points are 
viewed in the image as a linear variation between these extremes. 
 
Data triangular grab handles (contrast control) 
Adjusting the ‘Data’ triangular grab handles limits the range of values used to create 
the image. This therefore affects the contrast of the image. You can cross the 
triangles over to get an ‘inverse’ image. This may be useful to highlight differences 
over the mapped region. When ‘Dynamic’ is checked, any changes made occur in 
real time. If preferred, LUT values can be entered manually by adjusting the upper 
and lower limits. 
 

Colour selection 
 

Upper and lower 
transparency 

 
 

Opacity of image 
 

Upper and lower 
contrast 
 Automatic contrast setting 

based on data distribution 
 

Data histogram 
Contrast/transparency 

 

Histogram zoom 
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The ‘5% - 95%’ sets the data values to best represent this proportion of the data, i.e. 
offer no contrast for any data in the lower and upper 5% extreme. This is useful if 
erroneous values have been created in the image, due to cosmic ray features for 
example. 
 
Data triangular grab handles 
Adjusting the ‘Display’ triangular grab handles limits the range of colours used in that 
scheme.  
 
Data histogram zoom  
Grab the far left or far right part of the upper red trace to zoom into the lower red 
trace. 

 
Transparency control 
Dragging the left or right sides of the ‘Data’ part of the LUT produces darkened bars. 
Values within the range of these bars are made transparent in the viewed image. 
 
If preferred, transparency values can be entered manually by adjusting the upper and 
lower limits. 
 
Opacity control 
Reducing the percentage value from 100 makes the selected volume image semi-
transparent. This is useful where multi-volumes are shown at the same time, and 
volumes are contained within other volumes. 

 
 
Controlling the volume view mode 
 
There are three different view modes; volume, slice, and plane. These modes are 
individually selected using the buttons indicated below.  
 
 

 
 
 
For the slice and plane view modes the displayed plane or plane combinations (for plane 
view mode) can be specified. 

View entire volume 

View volume slice 

(+ve side) 

View plane 

View volume slice 

(-ve side) 
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The practical use of these options is shown below for a core inclusion in silicon carbide 
 

• Volume 

 
 

o The entire volume is displayed 
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o The entire volume is displayed with transparency. Here the first transparency 
value has been increased from -0.0231 to 0.0986. Making all the values 
below this transparent. 

 

 
 

 
It is not possible to select different planes or individual spectra in Volume mode. 
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• Slice 

 
 

o The slice option can be shown for X, Y, and Z planes separately 
o For each plane the +ve or –ve side can be shown 
o Hold down the mouse wheel button and select the face of the slice, move the 

mouse to drag the slice 
 

The 2D plane image changes instantly as the slice is changed  
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• Plane 

 
 

o The plane can be shown individually or together for X, Y, and Z 
o Hold down the mouse wheel button and select the face of the plane, move the 

mouse to drag the plane 
 

The 2D plane image changes instantly for each selected plane 
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Controlling the axes view mode 
There are three axes modes that can be viewed individually, in combination, or not at all. 
These modes are selected using the buttons indicated below.  
 
 

 
 
 
 
The boundary box and axes buttons are used to display boundary limits and XYZ axes, 
respectively. The wireframe button places a wireframe view around the boundary limits, 
offering the user the capability to easily size small particles. 
 

 
 
 
The axes labels tick length and frequency can be altered by selecting Edit...Format 
Settings 

Boundary box Axes 

Wireframe  
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Clicking the ‘Format’ button within the ‘Main Window’ section allows the user to set the main 
window font.  
 

 

 
 

 
 
Creating an animation  

Animations can be created within the volume viewer under View......Animation. Two 
animation modes are available; slicing and rotation.  
 

• Slicing 
The animation runs through volume slices. The view mode prior to entering the 
animation control window is irrelevant here; the animation will run through entire 
slices over the full volume of the image regardless of which view mode the image 
was in. The axes mode will remain as set within the volume viewer excepting the 
case where the wireframe is turned on; upon entering the slicing animation, the 
wireframe will automatically turn off.  
 
To set up a slicing animation: 

o The user must select the desired axis through which to step the slices, along 
with the step interval (ms/interval). Note that the desired step interval is input 
by the user. Upon exiting the animation, the achieved step interval is output 
by the software.  
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o The manipulate slices slider controls the frequency of slices that will be 
present within the animation; a higher manipulate slices value will result in an 
increased number of slices, whereas a lower value will result in fewer slices 
being stepped through within the animation. 

o If snake mode is selected, the animation will run through the slices starting 
from the lower value of the selected axis, running up to the top slice, before 
running back down to the bottom slice, and repeating – i.e. a multi-directional 
animation will be produced. If raster mode is selected, the animation will run 
from the bottom of the axis to the top and will then immediately start from the 
bottom again – i.e. the animation will run in one direction only.   
 

 
 
 

• Rotation 
The animation rotates the image around the selected axis. The image view mode set 
prior to entering the animation control is relevant here; the image will remain in its’ 
user set state throughout the animation. This is inclusive of all view control and axes 
modes. If the wireframe is turned on prior to opening the animation control dialogue, 
it will remain on throughout the rotation animation (this differs to the axes modes 
available within the slicing animation). The exception to the above rules is the case 
where a slicing animation is first performed. In such a case, the rotating image will 
appear as upon exiting out of the slicing animation. 
 
To set up a rotation animation: 

o The user must select the desired axis around which to rotate the image, along 
with the step interval (ms/interval) and the rotation step per interval (degrees). 
Note that the desired step interval is input by the user. Upon exiting the 
animation, the achieved step interval is output by the software. 
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o If ‘Use object axis’ is selected, the object will be rotated about its centre (and 
around the previously selected axis). If ‘Use view axis’ is selected, the object 
will be rotated about the volume boundary axes. 

 

 
 

For both slicing and rotation animations, the animation is started by clicking the ‘Start 
animation’ button. If the user wishes to save a recording of the animation, the file name and 
location can be specified under Browse prior to starting the animation. Pressing the record 
button will record and save the animation as an ‘AVI’ format to the specified location. The 
record button can be pressed at any point during the animation, so that the whole or a part of 
the animation may be saved. If the record button is pressed prior to the ‘Start animation’ 
button, the animation will be recorded from the start of the animation. The recording can be 
ended either by again pressing the record button, or by clicking the stop button which will 
also end the animation. Note the ‘Start animation’ turns to ‘Stop’ upon beginning the 

animation. While recording, the record button is highlighted green  and when not 

recording, it is red . 
 

 
Viewing spectra from the volume 
 
Spectra can be viewed in Slice or Plane mode. Use the left mouse button to click on the 
plane to see the spectrum. In these modes the spectrum will update as the plane or slice is 
changed. 
 
The X, Y, and Z keyboard keys can be used to select different spectra within the plane. Used 
in conjunction with the shift key, the direction of travel is reversed. A small delay may be 
observed as the individual spectrum is displayed from the large multifile. 
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A cursor indicates on the image the location from which the spectrum is displayed. The 
cursor can be removed from the view by unselecting View....Selected point. 
 
 
Multiple volumes and opacity 
 
Up to three volumes can be shown together. In such cases it is often convenient to make 
one or more of the individual images semi-transparent. This can be done by reducing the 
opacity value. 
 

• Multiple volumes with no reduced opacity 

 
 

• Multiple volumes with reduced opacity (20%) for red and green images 
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Adding the white light image 
 
By selecting Edit...Add white light image we can project the white light image under the 
volume. 
  

 
 
 
Controlling the Z scale of the volume image 
 
The Z scale has additional control to account for refractive index (RI) effects as the laser 
light travels from air into the material. 
 
This process has several affects on our data: 
 

• The depth analysed is deeper by a factor of the RI of the material compared to the 
distance the sample has moved in Z 

• The confocal collection volume becomes larger as we collect at deeper depths within 
the sample 



TM011-03-A  3D imaging 

 
 

- 17 - 

 
Select View.....Scaling adjustments to access adjustment to the Z scaling within the image. 
 

 
 

Adjusting the scaling factor will stretch the image in Z compared to XY. The Z origin defines 
from where in Z the scaling factor is applied. 
 
If the Change scale box is ticked the Z values increase as the image is stretched in Z. 
 
For a volume image of stressed ruby, this feature would be used in the following way: 
 
Initially the scaling factor is set to 1. The Z scale therefore represents the distance the 
sample has travelled in Z. 0 µm is the sample surface, -10 µm is 10 µm into the sample. 
 

 
 
The refractive index of the ruby is approximately 1.77 at 532 nm. 
 
Now the scaling factor has been set to 1.8 with the change scale box ticked. The Z origin is 
set to 0 (the sample surface). 
 



TM011-03-A  3D imaging 

 
 

- 18 - 

 
 
Now we can see the Z axis values have been stretched by a factor of 1.8 such that the 
bottom of the image is now at -18.00 µm. The Z scale represents the analysis depth within 
the sample (to a first approximation) and shows a more realistic representation of the volume 
in X, Y, and Z. 
This correction procedure can be avoided through the use of index matching immersion 
objectives. Here the refractive index difference is minimised by using oil which has an RI 
much closer to that of the sample compared with air. In the case where the RI’s are identical 
the distance the sample has travelled in Z is the same as the analysis depth. 
 
 
Exporting the volume image 
 
The volume image can be copied using Edit......Copy to Clipboard or directly saved as a 
Jpeg using Edit......Save Image. 
 

Exporting slices from the volume image 
 

In either plane or slice mode, right click on the X, Y, or Z plane image on the right hand side 
of the window. 

Select: 

• ‘Export nearest slice to 2D wdf file’ – enables a new wdf file to be generated, 
consisting of just that XY plane.  
 
If the plane shown in the image is interpolated between real spectral slices the 
nearest data slice will be exported. In this case the image observed in WiRE from 
the new file may not be identical to that seen in the volume viewer. 

The new wdf file can be processed and analysed in WiRE in exactly the same way as 
one collected natively in that way. 

 
• ‘Export slice as image’ – enables the exact shown image to be saved as a .jpg. 
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In volume mode only, the z profile can be directly exported from the volume image using 
Edit... Z-Profile. A tick box next to Z-Profile indicates this mode is turned on. This option 
restricts access to the View tab and View Control options. Left click on the volume image to 
select the desired z-profile location to be exported, then right-click & Save as the desired 
format (txt or wdf). 

 

To exit out of this mode, again select Edit....Z-Profile so that the tick box next to ‘Z-Profile’ 
disappears and the View tab and View Control options are accessible to the user. 


